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Refugees, Immigrants, Migrants

|
e |mportant members of communities

e Diverse in culture, language, countries
of origin, occupations, educations,
motivations, etc.

e Strong, resilient, dedicated to family
and community

e Some face health disparities NS T
ONRC-RIM
& www.nrcrim.org Retgass, et Mpais




RIM Communities and COVID-19

e Disproportionately affected by
COVID-19

e NoO genetic, biological reason

e Systemic health, social inequities

o Working conditions

o Prevention/mitigation is difficult

o Barriers to healthcare access

National Resource Center for
Refugees, Immigrants, and Migrants

& www.nrcrim.org




Project
Background
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About NRC-RIM

e Funded by the CDC, housed at University of Minnesota

e (Goals:

o Strengthen partnerships between health departments anad
RIM communities

o Support health departments and CBOs that work directly
with Refugees, Immigrants, Migrants

National Resource Center for
Refugees, Immigrants, and Migrants

& www.nrcrim.org




What we do

e Best and promising practices

e Health communications and health education
e Training

e Technical assistance

e Pilot Projects (NACCHO Partnership)

& www.nrcrim.org



Core Partners
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Community Leadership Board

e 13 members from RIM
communities

e (Governance body

e Inform decision-making +
priorities
e Review materials

e Offer guidance

& www.nrcrim.org




Vaccine
Resources

National Resource Center for
Refugees, Immigrants, and Migrants



Vaccine Central

O

NRC-RIM

e Fvent plans

COoVID-19 V4 - 3 g e (sl
) ) VACCINE FACTS ARABIE
Guide: Addressing

Immigration-Relat . .
C {‘//L‘)\\ The vaccine is safe and effective.
A dtrentracon . a | n O | n
100 P0)  ethic groups, genders, and ages. S

Imemigeants may have concerns |
provided at vaccine clinics. For s|
overnment processes is novel
8 P The vaccine cannot give
you COVID.
+ Thelr information will be
electronic regisiries that |

authorites.

Having side effects (flu-like | I\ Q S
symptoms) FOR A DAY OR TWO)|
normal and means the vaccine i

working!

s~ I 2 e Fact sheets with translations

The vaccine does NOT change
your DNA.

Health departments or v
immigrants to authorities

Healthcare professionals
are hostie to immigrants
authorities - espedally f
Interaction with them at{

Records indicating that t
including vaccination, will
petitions based on the U}

Confidentiality concerns can vary

« Providing home address(
immigration raids.

e 20+ Promising practices from
s around the country

Disclosing health conditiq
immigrants may fear that
desirable as US residents
by wearing a mask, staying 6 feet
The Natorsl Resaurce Centr fo Refugees,

a1 Preveninto suppert st ans sl g
updte: 1572021

(2 meters) apart, and washing yot
hands often

PROTECT YOURSELF. PROTECT YOUR LOVED ONES. GET VACCINATED
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National Resource Center for
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Translated Materials Library

e /000+ Items
e 17/5+languages
e Multiple formats
e Video
e Audio
e Printed
o Websites

( ) NRC-RIM
i National Resource Center for
@ WWW' n rc rl m . O rg Refnngees, Immigrants, and Migrants




Health Education Videos

Interviews with faith leaders

Testimonials from healthcare
providers

Vaccine explainers
Translations

Video Booth service

@ www.nrcrim.org
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Imam Wazir on Vaccinations
in Islam
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Reflections: How COVID-19
Changed Our Lives




Three Campaigns
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Culturally and Linguistically Relevant
Communications Strategies

Listen Write Design Translate Scale
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Culturally and
Linguistically
Relevant
Communications
Strategies

1.

Partner with
community
representatives on
the content, format,

and dissemination
of health
communications
materials.

National Resource Center for
Refugees, Immigrants, and Migrants




Partner with Communities

Listening sessions and focus groups

CBO + local government partnership
Online or in-person
Community leaders as facilitators

Ask about knowledge, perceptions,
beliefs

|[dentify distribution and format options

& www.nrcrim.org

COVID-19 Vaccine Community
Listening Session

COMMUNITY
DISCUSSION
COVID-19 VACCINE

SATURDAY 10/17/2020 | 4PM
VIA ZOOM
EMAIL INFO@AFGHANHEALTH.ORG TO REGISTER*
*REGISTRATION LIMITED TO FIRST 15 PEOPLE

Afghan 7 SPONSORED BY
\ Initiative /

National Resource Center for
Refugees, Immigrants, and Migrants



Partner with Communities

Content Advisors
e Weekly meetings with IRC, MCN

e Monthly meetings with Community

Leadership Board ‘ ‘

e [ncorporate RIM community m
perspectives

e Informs topics, framing, media

( ) NRC-RIM
i National Resource Center for
@ WWW' n rc rl m . O rg Refugees, Immigrants, and Migrants




How might
partnering with
communities nelp
you stay on-budget
in the long term?
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2.

CU ItU 'a | Iy an d Incorporate diverse

perspectives into

LiﬂgUiStiCa”y the communication

Re|eva Nt of guidelines
released by the CDC

Communications |y
Strategies health authorities.

National Resource Center for
Refugees, Immigrants, and Migrants




Writing

e Align with trusted sources
e Convertto simple language

e Frame with RIM Community
Perspective

e Double check for medical
accuracy

& www.nrcrim.org

,’

nnnnn



Simple language: Example

Everyone who has presumed Staying home from work, school,

or confirmed COVID-19 should or social events anytime you feel
sick is one of the most important

things you can do to protect your

stay home and isolate from
other people for at least 5 full

days. They should wear a mask community.
when around others at home When you test positive, you will
and in public for an additional need to stay home and away from

others for 5 days and wear a mask
for 5 more days.

O NRC-RIM
& www.nrcrim.org Retgass, et Mpais

5 days.




Simple language: Example

Post-COVID conditions are a
wide range of new, returning,
or ongoing health problems
people can experience four or
more weeks after first being
infected with the virus that
causes COVID-19.

& www.nrcrim.org

Many people get long-term
side effects from a COVID-19
infection. These long-term
effects have negatively

impacted hundreds of
thousands of people’s quality
of life.

National Resource Center for
Refugees, Immigrants, and Migrants



Activity: Simple Language

Before recommending ..Write your own.
COVID-19 vaccination for
children, scientists conducted
clinical trials with thousands of
children and no serious safety
concerns were identified.

O NRC-RIM
& www.nrcrim.org Retgass, et Mpais




Incorporating Community Perspectives

]
e Example: Fertility Fact Sheet WGETTHEEACE,M
o Keymessages e =

o Provide for one’s family
o Vaccinated parents protect children

o Vaccines safe at all stages in a
relationship

O NRC RIM

For more information; cde. gov/coronavirus

National Resource Center for
Refugees, Immigrants, and Migrants

& www.nrcrim.org




Incorporating Community Perspectives

VACCINES ARE SAFE:

BEFORE YOU WHILE YOU'RE AFTER YOU GIVE WHEN CHILDREN
HAVE CHILDREN PREGNANT BIRTH ARE OLDER

( } NRC-RIM
i National Resource Center for
@ WWW' n rc rl m . o rg Refugees, Immigrants, and Migrants




Culturally and
Linguistically
Relevant
Communications
Strategies

3.

Use photography
and design elements
that honor people

from many different
linguistic and
cultural
communities.

National Resource Center for
Refugees, Immigrants, and Migrants



Step 2: Create

9 = ANIMOTO

PIKTOCHART

Picture the Difference

O NRC-RIM
@ www.nrcrim.org Reges g aod Wirans




Step 2: Create

Pexels.com | Nappy.co | Plxabay com

National Resource Center for

Refugees, Immigrants, and Migrants

& www.nrcrim.org



Step 2: Create

& www.nrcrim.org O NRC RIM
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Step 2: Create

& www.nrcrim.org O NRC RIM
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Activity: Choosing a Stock Photo

Refugees, Immigrants, and Migrants

O NRC-RIM
@ WWW.Nrcrim.o rg National Resource Center for



Culturally and
Linguistically
Relevant
Communications
Strategies

4.

Ensure work is
rigorously translated
and validated by

community members
for both accuracy and
cultural
appropriateness.

National Resource Center for
Refugees, Immigrants, and Migrants




Translation

|

e language as a barrier to
vaccine access

e lLanguage as a barrier to
vaccine confidence

e Linguistically and culturally ‘

appropriate “

( ) NRC-RIM
i National Resource Center for
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Automatic Translators

e Acronyms
e Homonyms
e |dioms

e Metaphors

e Register/ Tone

e Cultural appropriateness

( ) NRC-RIM
i National Resource Center for
@ WWW' n rc rl m . O rg Refugees, Immigrants, and Migrants




Translation Process

Review
A s Linguist
Proofread
L » Professional
Initial Translator
translation
» Professional
Translator

O NRC-RIM
@ WWW.Nrcrim.o rg National Resource Center for

Refugees, Immigrants, and Migrants




Translation Process

High-quality contractors

e Translators from community
e \Work as ateam

e Translate message, not words

e (ollaborate to address tone,
idioms, etc.

& www.nrcrim.org




Translation Process

Competency
y : check
Review » Community
A * Linguist member
Proofread
L » Professional

Initial Translator
translation

» Professional

Translator

O NRC-RIM
@ WWW.Nrcrim.o rg National Resource Center for

Refugees, Immigrants, and Migrants




About Content Validation

Valuing expertise of community
e Paid opportunity
e Checkfor:

e Accuracy

e Comprehension and tone

e Culturally competent
language and photos

( ) NRC-RIM
i National Resource Center for
@ WWW' n rc rl m . O rg Refugees, Immigrants, and Migrants




Importance of Content Validation

]

Swahiligate

e One of our first translations NIMEPATA CHANJO
e Not content validated YANGU YA

e Violentimagery, not healthcare CUV|D'19|

e FExtremely culturally insensitive

S
%

&
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Step 3: Translate

Confirmation

* Linguist
Competency
y : check
Review » Community
A * Linguist member
Proofread
L » Professional

Initial Translator
translation

 Professional

Translator

Refugees, Immigrants, and Migrants

O NRC-RIM
@ WWW.Nrcrim.o rg National Resource Center for




How might you
recruit community
reviewers for your
products?
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Culturally and
Linguistically
Relevant
Communications
Strategies

S.

Scale your work so
that partner
organizations and
health departments
can have a consistent
message and
far-reaching impact.

National Resource Center for
Refugees, Immigrants, and Migrants



Customizable Templates

b ShortFactSheet-French ¥ B & B [E- [ sideshow ~ [ & Share 1@

File Edit View Insert Format Slide Arrange Tools Add-ons Help Last edit was seconds ago

e e - -~ K B~ Q1 \ ~ Background = Layout~ Theme  Transition ~

1 2 3 4 5 6 7 8

NEW: Want to try a different look?
Check out the slides at the end of

- this presentation. Protegez-vous

Finished?
Go to File > Print Settings and
Preview. Unselect “Include Skipped
Slides” and click “Download as

Faites-vous vacciner. PDF”

& GetVaccinated Poster - English & © o

; Protégez votre communauteé.

ind You can change the photo to
another one in our photo bank that
represents your community:

o 1. Move the text out of the way,
2. Delete this photo
© 3. Copy/paste a photo from the
other slides. E s regard de limmigration

cin NE PEUT PAS

L cin est sin ot efficace. Lo
Aueun sutie vaccin pour son inn

4. Resize the photo to fit by

™ clicking on one of the corners ¥
i i i 1l est normal d'é ondeires
and dragglng i Wﬂh your (! v nt Que e vacon apprend & votre corps i se battre contre
mouse.
= 5. Right click the photo, select Vous devriez vous faire vacciner méme si vous avez défa eu la COVID-19

If you'd like, remove this logo and
add your own. Just click it and press
“delete” on your keyboard. You can
also add your logo in the left corner
and keep ours in the right corner.

"Order” and then “Send to Back”

6. Move the text to its original
position

10

OBy

‘ede.gov/coronavirus




Conversation Guides

Answer vaccine guestions
Build trust

Reinforce dignity and agency
Address misinformation

Scripts, tips, reminders

& www.nrcrim.org




Conversation Guides

Topics include:

e Boosters + third doses
Breakthrough infections
Children + youth
Employer requirements
Fertility + parenthood
Testing
Variants of concern
Wearing a mask

i m C j National Re: Center fo
@ WWW. n rC rl . 0 rg R:ﬂ:llis, I;?:i:r‘;n(sr,‘aer:d l;ligrants




Culturally and Linguistically Relevant
Communications Strategies

|
Listen Write Design Translate Scale
*Topics *CDC guidance *Stock photos *Rigorous translation «Confirm with linguist
*Medium «Simple language *Design elements «Community review *Update designs
+Distribution *Diverse perspectives *Free tools *Accurate + culturally *Make customizable

appropriate

O NRC RIM

& www.nrcrim.org



Vaccine
Campaigns

National Resource Center for
Refugees, Immigrants, and Migrants



Get Vaccinated Campaign

e (oal: create awareness

Protéjase a usted mismo(a).

Proteja a su comunidad. e Based on community feedback
g e Available in 40+ languages
e Includes posters, social media assets

e (Customizable (logo, photo, URL, etc.)

O NRC-RIM
& www.nrcrim.org Retgass, et Mpais




Protect yourself.
Protect your loved ones.

Get vaccinated.

124

&

COVID-19 VACCINATIONS: SAFE AND EFFECTIVE

National Resource Center for National Resource Center for
Refugees, Immi ind Migrants Refugees, Immigrants, and Migrants

immigrants, and
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Vaccine Decisions Are Private

FREE. PRIVATE. @ CONFIDENTIAL.

COVID-19 vaccine
decisions are private.

Only you and your
doctor will know.

Schedule a
confidential
appointment today.

COVID-19 VACCINATIONS: SAFE AND EFFECTIVE

(R E

ede.gov/coronavirus | nrcrim.org

& www.nrcrim.org

FREE. PRIVATE. Jf CONFIDENTIAL.
&

Anyone can
get a free
COVID-19
vaccine in a
doctor’s office
at a private
appointment.

Protect yourself. Protect your community.
Get vaccinated.

COVID-19 VACCINATIONS: SAFE AND EFFECTIVE

@)l

cde.gov/coronavirus | nrcrim.org

FREE. PRIVATE. Jf CONFIDENTIAL.

COVID-19 vaccine
decisions are private.

Only you and your
doctor will know.

Schedule a
confidential
appointment today.

COVID-19 VACCINATIONS: SAFE AND EFFECTIVE
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‘ede.gov/coronavirus | nrcrim.org




Get the Facts Campaign

(HNREEM

& www.nrcrim.org

Goal: create understanding
Based on CDC guidance
Available in 40+ languages

Customizable (logo, photo, URL, etc.)

National Resource Center for
Refugees, Immigrants, and Migrants



Get the Facts Campaign

COVID-19 VACCINE

GET THE FACTS.

STAY SAFE AFTER BEING VACCINATED.
PROTECT YOUR COMMUNITY.

You are not fully protected from COVID-19 until i
two weeks after your last shot! @
- If you got the two-shot vaccine, you must wait 2 weeks after your second shot.

* Ifyou got the vaccine that only needs one shot, you must wait 2 weeks after
your shot.

STAY SAFE AFTER BEING VACCINATED

Experts don't know how long the vaccine will protect you from COVID-19 or if you can still spread
COVID-19 to others after being vaccinated. Even after getting the vaccine, continue to:

0O e ¢

Weara Practice Avoid gatherings Wash your Disinfect
mask social distancing. with many hands high-touch
people. frequently. areas.

Even if you are fully vaccinated, get tested for COVID-19 right away if:
You have been around someone with COVID-19 and start to feel ill. Also stay home and

Q away from others.
A
{.o&‘:‘s You live with many people and have been around someone with COVID-19. Even if you

do not feel ill, get tested. Also stay home and away from others.

& www.nrcrim.org

COVID-19 VACCINE

GET THE FACTS.

E

SAFE AND EFFECTIVE

Vaccines were made quickly
because there was decades
of previous research that
scientists could use.

<)

Audio +
Video PSAs

@

NRC-RIM

National Resource Center for
Refugees, Immigrants, and Migrants



Get the Facts Campaign

COVID-19 VACCINE

COVID-19 VACCINE

Topics:

GET THE FACTS.

o \/a rla ntS WEARING A MASK GET THE FAGTS

PROTECT YOUR CHILD. {* y PROTECT YOUR COMMUNITY.

Children + Yout
Breakthrough Infections

Masks

Fertility + Parenthood
Boosters + Third Doses

Employer Requirements

& www.nrcrim.org

IT IS ALWAYS SAFEST TO
WEAR A MASK

COVID-19 i stil infecting thousands
of people every day including elderly,
adults, teens and children. Regardless
of whether masks are required in
your area, you and your family will be
safestif you wear a mask.

Masks protect against COVID-19

Because COVID-19 spreads very easily, wearing a mask

protects you, your friends and family, and your community.
When you wear a mask, itis less likely that you will get
sick from breathing in the virus if it is in the air

o Itis possible to be sick with COVID-19 and not know it,
because not everyone feels sick. In this case, wearing a
mask makes it less likely that you will spread the virus

to others
MASKS MUST BE WORN PROPERLY TO
BE EFFECTIVE.
+ Wear your mask overyour Do not touch your mask
nose and mouth when it s on your face
* Make sure no airleaks out - Clean your reusable mask
the top or sides atleast daily
« Putyourmaskonandoff - Use your disposable mask

with clean hands

gEy
g

Vaccines provide the

most protection

+ Getting vaccinated is the most
important step for you to take
to protect yourself and your
communtty.

+ After getting fully vaccinated
itis unlikely you will get sick
from COVID-19, and evenif you
do, the vaccine will protect you
from getting dangerously il

EVEN VACCINATED PEOPLE
ARE SAFEST WITH A MASK
Itis uncommon for people to get
sick with COVID-19 after they are
vaccinated, but it can happen.
Getting a vaccine and wearing
amask are the best ways to
avoid getting sick and spreading
COVID-19 to others.

(CHNRCRIM

For more information: cde.gov/coronavinus

Children and youth will
be safest when they are
vaccinated.

The vaccine protects everyone, including
children and youth, from getting COVID-19. The
vaccine also prevents children and youth from
getting seriously il if they do get sick.

There are new COVID-19 variants, including the
Detta variant, which spread more easily and may
cause more severe symptoms. Vaccines protect
against variants like Delta

Vaccinating children and
youth protects the whole
community.

Once someone is vaccinated, it is more difficult
to spread COVID-19 to others. When eligible
children are vaccinated it protects:

« Their friends and family who are not yet
vaccinated.

+ The elderly and people with certain medical
conditions who are at high risk of getting
seriously ill from COVID-19.

As more children and adults get vaccinated,
it will also be easier to keep schools and
businesses open.

+ No other vaccine has been tested as much

« The vaccine has been proven safe for

+ There is no evidence the vaccines will

« Neither you nor your child need to show

SAFE AND EFFECTIVE

forits safety in U.S. history.

children, youth and adults, including those
of different races, ethnicities and ages.

make your child unable to have their own
children someday.

FREE FOR EVERYONE

You and your child can get a free vaccine
regardless of immigration status.

an ID or have health insurance to receive a
free vaccine.

( NRC-RIM

For more information: cde.gov/coronavirus

NRC-RIM

National Resource Center for
Refugees, Immigrants, and Migrants



Languages

]
® Amharic ® Hmong ® Mixteco ®  Somali
® Arabic ® Karen ® Nepali ® Spanish
® Burmese ® Karenni ® Oromo ®  Swahili
® (antonese ® Korean ® Pashto * Tagalog
® Dari ® Kinyarwanda * Popti' *  Tamil
® English * lao ®  Portuguese ® Tigrinya
® Farsi ® Lingala ®* Q'anjob'al ® Ukrainian
® French ® Mam ® Rohingya * Urdu
® Haitian Creole ® Mandarin ® Russian ® Viethamese

® Hakha Chin * Marshallese ®  Sango ONRC-RlM

National Resource Center for
Refugees, Immigrants, and Migrants




“Waccination Is” Campaign

e (oal: co-create campaigns in

partnership with target communities

e Ready-to use materials in support of
Iraqi, Latino, Haitian, Congolese, Afghan,
Somali, Bhutanese, Ukrainian

communities

( ) NRC-RIM
i National Resource Center for
@ WWW' n rc rl m . o rg Refugees, Immigrants, and Migrants




Makespace

& www.nrcrim.org

Make customized vaccine
messaging that meets the

needs of local communities

Drag-and-drop templates

and easy-to-use guide

National Resource Center for
Refugees, Immigrants, and Migrants



Makespace

& &
Lessons Learned re: & & W

Human-Centered Design
in Emergency Public
Health Response

NRC-RIM + IDEQ.org
April 5 at 8:30 a.m.

9

National Resource Center for
Refugees, Immigrants, and Migrants

& www.nrcrim.org




Three Campaigns
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Fast-Changing
Guidelines

National Resource Center for
Refugees, Immigrants, and Migrants



Writing tips

IT IS ALWAYS SAFEST TO
WEAR A MASK

COVID-19 is still infecting thousands
of people every day including elderly,
adults, teens and children. Regardless
of whether masks are required in
your area, you and your family will be
safest if you wear a mask.

( ) NRC-RIM
i National Resource Center for
@ WWW' n rc rl m . o rg Refugees, Immigrants, and Migrants




Design tips

COVID-19 VACCINE

AV4,°W

GET THE FACTS. =

BOOSTERS ARE SAFE

COVID-19 vaccines o
ff t. COVID-19 boosters have the same ingredients
are efrective as the original vaccines, which have been
) X proven safe for hundreds of millions of
COVID-19 vaccines are very effective. If people. Mild side effects are normal. Serious
you are fully vaccinated, you are unlikely side effects are very rare.

to get infected with COVID-19 and spread
it to loved ones. Even if you are infected,

the vaccine prevents you from getting
dangemus'y § _mm

National Resource Center for
Refugees, Immigrants, and Migrants

) NRC-RIM
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Conversation Guides

e Answer vaccine guestions
e Build trust

e Reinforce dignity and
agency

e Address misinformation

e Scripts, tips, reminders

& www.nrcrim.org




Emerging issues

[ ———
Audience: Communities Audience: Staff
Translated English only
Evergreen Updated regularly
General statements Specific guidance

( ) NRC-RIM
i National Resource Center for
@ WWW' n rc rl m . o rg Refugees, Immigrants, and Migrants




How to Reach Us

]
Q @nrc_rim WWW.Nrcrim.org
ﬁ @nrcrim nrcrim@umn.edu

National Resource Center for
Refugees, Immigrants, and Migrants




Www.nrcrim.org/prepsummit

National Resource Center for

Refugees, Immigrants, and Migrants



